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Product Registration
When you receive your Nortek instrument it is important that you visit our website and 
register the instrument to activate the warranty, you’ll find the form here:

www.nortek-as.com/support/customer-warranty/warranty-form

Software updates and technical support 
For software updates and technical support:

www.nortek-as.com/support

Nortek Forum Support
If you have comments, tips, suggestions for improvement or any other information that you 
think may be of interest then you should join the Nortek Forum:

www.nortek-as.com/forum

The Forum offers a great opportunity for you to share your experiences of using Nortek 
instruments and allows you to benefit from other’s.

Your Feedback is appreciated
Your feedback is much appreciated. If you find errors, spelling mistakes, omissions or sec-
tions poorly explained or have any other comments on this manual please let us know, email 
us at:

inquiry@nortek.no

Contacting us
If you need more information, support or other assistance from us, do not hesitate to contact 
us:

Nortek AS
Vangkroken 2
NO-1351 RUD, Norway
Phone: +47 6717 4500, Fax: +47 6713 6770
e-mail: inquiry@nortek.no

User manual
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CHAPTER 1
Introduction

The Aquadopp profiler is 
available with a variety of head 
configurations.

	 Thank you for purchasing a Nortek Aquadopp® Profiler. The Aquadopp Profiler 
has been designed to give you many years of safe, reliable service.

The Aquadopp Profiler measures the current profile in water using acoustic Doppler 
technology. It is designed for stationary applications and can be deployed on the 
bottom, on a mooring rig, on a buoy or on any other fixed structure. It is a complete 
instrument and includes all the parts required for a self contained deployment with 
data stored to an internal data logger. Typical applications include coastal studies, 
online monitoring and scientific studies in rivers, lakes, and channels.

The Aquadopp Profiler uses three acoustic beams slanted at 25° to accurately 
measure the current profile in a user selectable number of cells. The internal tilt 
and compass sensors tell the current direction and the high-resolution pressure 
sensor gives the depth—and the tidal elevation if the system is fixed mounted. The 
standard 9 MB recorder and internal alkaline batteries are typically sufficient for 
a 2–4 month deployment.

Deployment times can be increased or sampling schemes intensified by expanding 
to 161 MB memory and external lithium or even rechargeable batteries. Further ex-
pansion is available through the use of external battery canisters.

Practical Use
One quick glance at the Aquadopp profiler tells you that it is a small and practi-
cal current profiler that is simple to deploy. It gives you the full current profile 
and it comes standard with all the trimmings such as a internal recorder, com-
pass, tilt, pressure, temperature, software, cable, etc. 

Aquadopp is a registered 
trademark of Nortek AS
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Getting Started
To get you up and running: 

1	 Before you start using the Aquadopp, please familiarize yourself with the 
Current Profiler by reading Chapters 2, 3, and 4 of this user guide.

2	 Perform reception control and functional test of the Aquadopp according to 
procedures in Chapter 5. 

3	 Start using the Aquadopp according to procedures in Chapter 6.

4	 Perform regular maintenance according to procedures in Chapter 10

Warranty
In order to stay up-to-date and receive news and tips from the factory you should 
register at our web site. Use the Internet and go to http://www.nortek-as.com/
newsletter.php. Enter your name, e-mail address and topics of interest. 

We also recommend our User Forum where you may post questions and discuss 
with other people in the oceanographic community. To get to the User Forum 
enter http://www.nortek-as.com and click on Forum. If you have no internet ac-
cess or, if you—for any other reason—prefer traditional mail or telefax, you may 
fill in and return the registration part of the warranty sheet accompanying your 
Nortek product.

Nortek AS grants a one year limited warranty that extends to all parts and labour 
and covers any malfunction that is due to poor workmanship or due to errors in 
the manufacturing process. The warranty does not cover shortcomings that are 
due to design, nor does it cover any form of consequential damages as a result of 
errors in the measurements.

In the unlikely event of trouble with your Nortek product, first try to identify the 
problem by consulting the documentation accompanying your Nortek product. 
If you need further assistance when trying to identify the problem, please con-
tact your local Nortek representative or the factory.

Please make sure you receive a Return Merchandise Authorization (RMA) 
before any product or module is returned. An RMA can be obtained using our 
e-mail address: inquiry@nortek.no or our Fax No.: +47 6713 6770. See also the 
Appendix.

CHAPTER 1
Introduction
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CHAPTER 2
Technical Specifications

	 Water velocity measurement
Acoustic frequency: 	 0.4 MHz	 0.6 MHz, 	 1.0 MHz, 	 2.0 MHz
Maximum profiling range*: 	 60–90 m	 30–40 m 	 12–20 m 	 4–8 m
Cell size: 	 2–8 m	 1–4 m 	 0.3–4 m 	 0.1–2 m
Minimum blanking: 	  1m	 0.50 m 	 0.20 m 	 0.05 m
Maximum number of cells: 128
Velocity Range: ±10m/s (call for extended range)
Accuracy: 1% of measured value ±0.5 cm/s
Max. Sampling rate: 1Hz
Velocity uncertainty: Consult software program

*) The Aquadopp profiler measures the current profile in a user specified number of cells from the 
instrument out to a maximum range that depends on the acoustic scattering conditions. The lower 
range should be expected with clear water and small cells and the higher range with large cells 
and acoustically turbid water.

Echo intensity
Sampling: Same as velocity sampling rate
Resolution: 0.45 dB
Dynamic range: 90 dB

Transducer
Frequency: 		  0.4 MHz	 0.6MHz 	 1.0MHz 	 2.0MHz
Number of beams: 	    3		     3 	    	    3 	    	    3
Beam width: 	  	   3.7°		    3.0° 	  	   3.4° 	  	   1.7°
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Standard sensors
Temperature sensor: Thermistor embedded
	Range: –4°C to 40°C
	Accuracy/resolution: 0.1°C/0.01°C
	Time response: 10 min

Compass sensor: Flux gate with liquid tilt
	Maximum tilt: 30°
	Accuracy/resolution: 2°/0.1°

Tilt sensor: Liquid level
	Accuracy/resolution: 0.2°/0.1°
	Up or down: Automatic detect

Pressure sensor: Piezoresistive
	Range: 0–100 m (standard)
	Accuracy/resolution: 0.25%/0.005% of full scale

Analogue inputs
Number of channels: 2
Voltage supply: Battery voltage. Hardware can be modified to provide 5 V or 12 V
Voltage input:	0–5 V
Resolution: 16 bit A/D

Serial data communication
I/O: RS232, RS422. Software supports most commercially available USB–RS 232 
converters
Baud rate: 300–115200 (user setting)

Internal recording
Capacity: 9MB, expandable to 33, 89, or 161MB 
Data record: 32 bytes + 9×NCELLS
Mode: Stop when full (default) or wrap mode

Software “AquaPro”
Operating system: Windows®2000, Windows®XP
Functions: Deployment planning, data retrieval, ASCII conversion, online 
data collection, and graphical display

Power
DC Input: 9–16 VDC
Max average consumption at 1Hz: 0.2–1.5 W
Sleep consumption: 0.0013 W
Transmit power: 0.3–20 W, 4 adjustable levels

CHAPTER 2
Technical Specifications
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Internal batteries
Type/capacity: 18 AA Alkaline cells/50Wh
New battery voltage: 13.5 VDC
Duration (10-minute avg.): 80 days for 2 MHz, 0.5 m cells
Duration (10-minute avg.): 50 days for 1 MHz, 1.0 m cells 
Duration (10-minute avg.): 40 days for 600 kHz, 2.0 m cells 
Duration (10-minute avg.): 20 days for 400 kHz, 2.5 m cells
Exact battery consumption and velocity uncertainty are complex functions of the deployment 
configuration. Please consult the AquaPro software for more exact predictions.

Ø 75
Ø 100

120°

562

25°

Ø 75600 kHz

1 & 2 MHz

1 & 2 MHz

120°

25°

616
All dimensions are in mm unless indicated otherwise
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CHAPTER 2
Technical Specifications

Dimensions
Weight in air: 2.4 kg / 2.6 kg (0.6MHz) / 3.7 kg (0.4 MHz) with alkaline batteries
Length: See drawing on previous page
Diameter: See drawing on previous page

Materials
Standard: Delrin and polyurethane plastics with titanium screws

Connectors
Bulkhead (Impulse): MCBH-8-FS
Cable: PMCIL-8-MP on 10-m polyurethane cable

Environmental
Operating temperature: –5°C to 35°C
Storage temperature: –20°C to 45°C
Shock and vibration: IEC 721–3–2
Shallow water rating: 300 m. This applies to all parts except the pressure sensor. 
The pressure sensor can withstand a max depth of 1.5 times its rating. Depend-
ing on the pressure sensor ordered, this may be the limiting factor determining 
the maximum deployment depth permitted. 

Options
Batteries: Lithium, Li-Io rechargeable
External batteries: 200 Wh, 540 Wh or 1080 Wh alkaline
Bulkhead connectors: Titanium instead of bronze
Transducer head: Right angle head for 1 or 2MHz. Special configurations 
available on request.
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CHAPTER 3
Technical Description

Above: The 1 MHz and the 2 MHz 
profilers are available with the 
two leftmost head configurations, 
while the 600 kHz profiler (to the 
right) has a slightly larger head. 
Below: The 400 kHz version has 
an even larger head.

	 The illustration shows the Aquadopp Profiler variants. The 400 kHz model has 
a much larger head and the 600 kHz model has a slightly larger head than the 
1 MHz and the 2 MHz versions. 

Aquadopp Profiler Components
	 The sensor head contains three acoustic transducers, the tilt sensor, the 

temperature sensor, and the pressure sensor:

•	 The Tilt sensor is mounted on a small separate pcb (printed circuit board)  
attached to the head, inside the case. The tilt sensor orientation is set in ac-
cordance with the system orientation during normal operation. The standard 
Aquadopp is designed for vertical orientation. However, tilt sensors in heads 
designed for horizontal orientations will be mounted so they fit this type of 
orientation. All Aquadopp Profilers can be used upside down (relative to the 
designed orientation) without problems.

•	 The Temperature sensor is standard on all Aquadopp Profilers and is mount-
ed inside the sensor head.

•	 The Pressure sensor is moulded inside the Aquadopp Profiler sensor head.

Other components include:

•	 Electronics module. The electronics consist of a board holding the power 
transmitter, analogue and digital signal processing circuitry, power condition
ing module, and a 9 MB data recorder.

•	 Compass. The built-in magnetometer measures the earth’s magnetic field. 
Combined with the tilt sensor on the head, this forms a compass, which  enables 
the Aquadopp Profiler to obtain the heading. These data enables the Aquadopp 
Profiler to convert velocity measurements to Earth coordinates. Observe that 
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without a magnetometer, the Aquadopp Profiler still measures the tilt.

•	 Internal battery pack. The internal battery pack is located inside the pressure 
case, and enables autonomous deployments of up to a year. It also provides 
backup power in the event of failure of the external supply. Standard alka-
line battery packs use 18 AA cell batteries at a nominal starting voltage of 
13.5 VDC. 

•	 Power & communication cable. The power and communication cable is 
connected to the external connector. The cable supplies external DC power 
(9–16 V) and connects an external computer to the Aquadopp Profiler for two-
way serial communication.

Cable Wiring

Tip! NORTEK alkaline battery 
packs start life at a voltage of 
13.5 VDC or higher. The voltage 
of alkaline batteries falls quickly 
at the beginning, slowly during 
most of its life, then again quickly 
at the end. Thus a 13.5 VDC 
battery pack will spend the 
largest part of its life somewhere 
in a voltage range of 10.5–
12.5 VDC. 

	 The Aquadopp comes standard with an 8-conductor RS 232 cable, but it can be 
ordered with an 8-conductor cable for use with RS 422 communication. The 
tables list the pin assignments for cable wiring options offered. 

The Aquadopp power and battery lines are diode protected, so you don’t have 
to worry about wiring the Aquadopp power backwards – this will not damage 
your instrument.

Power Requirements Using RS 422
Caution! Be sure to use silicone 
spray and not silicone grease on 
the dummy plugs and the cables. 
The use of silicone grease on 
these may cause permanent 
damage to the system! Silicone 
grease should be applied to the 
O-rings only.

	 RS 422 power requirements are higher than those of RS 232, and harder to 
predict. RS 422 increases sleep power consumption to at least 60  mW and it in-
creases operational power consumption by 60–250  mW, depending on how the 
RS 232/RS 422 converter is terminated. Since RS 422 is normally used in real 
time operations, you may supply the additional required power from an external 
power source.

CHAPTER 3
Technical Description

Acoustic 
sensors

Pressure 
sensor

Sensor head Tilt sensor Compass

Battery 
bulkhead

End bell  
with  

O-rings

Battery 

Desiccant O-rings

Pressure 
case

The main parts of an Aquadopp 
Profiler

Extended  
memory  

board 
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Wiring of RS 232 cable with analogue input
Underwater connector Termination

Pin No. Wire colour Purpose Pins Description
3 black RS 232 Tx twisted 

pair
2

4 white RS 232 Rx 3
5 black RS 232 Gnd twisted 

pair
5

6 white/purple Power output
7 black Analogue ch 2 twisted 

pair8 white/orange Analogue ch 1
1 black Power Gnd twisted 

pair2 white Power +
screen bare Gnd ground 3 bare wires for Gnd, connected 

internally to power Gnd

15

69

+

–
Ø  5.5 mm

Ø  2.1 mm

Wiring of 8-conductor cable for RS 422 communication
Underwater connector Termination

Pin No. Wire colour Purpose Pins Description
3 black RS 422 Tx+ twisted 

pair
7

4 white RS 422 Tx– 2
7 black RS 422 Rx+ twisted 

pair
8

8 white/purple RS 422 Rx–      3
5 black Synch. out twisted 

pair6 white/purple Synch in
1 black Power Gnd twisted 

pair2 red Power +
screen bare Power Gnd ground 3 bare wires for Gnd, connected 

internally to power Gnd

Note! Tx and Rx refers to the 
Aquadopp and not to the PC!

Caution! Be sure to use silicone 
spray and not silicone grease on 
the dummy plugs and the cables. 
The use of silicone grease on 
these may cause permanent 
damage to the system! Silicone 
grease should be applied to the 
O-rings only.

End bell and plug

12
3

4 5
6
7

8

Ø  2.1 mm+

–
Ø  5.5 mm

15

69
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CHAPTER 4
Functional Description
This chapter briefly describes some of the underlying principles that control the 
operation and application of the Aquadopp Profiler.

Modes of Operation
Tip! If you set the Aquadopp 
Profiler to collect data, remove 
the power, then reapply power 
later, the Aquadopp Profiler 
will immediately resume data 
collection. Remember that the 
internal clock may have lost the 
correct time of day.

	 The Aquadopp Profiler has three different modes of operation:

•	 Command mode. An Aquadopp Profiler in Command mode is powered up 
and ready to accept your instructions. If no commands are received for ap-
proximately five minutes, it will automatically power down and enter Sleep- 
or Power down  mode. 

	 Most commands cannot be sent directly to the Aquadopp Profiler. These 
commands include i.a. the deployment setup commands. Instead, you must 
enter commands through the AquaPro software. The AquaPro software and 
hardware interact with each other using low-level binary data structures. This 
approach simplifies the design of the AquaPro hardware and increases its 
overall reliability. 

•	 Data acquisition mode. The Aquadopp Profiler enters the Data acquisition 
mode when you click any of the Start commands (i.e. Start Recorder Deploy-
ment in the AquaPro software. When you initiate a deployment sequence, the 
software converts your setup parameters into binary structures, downloads 
the structures to the Aquadopp Profiler and tells it to start data collection. 

	 To get the instrument out of Data acquisition mode, use one of the Stop com-
mands in the AquaPro software. You might notice that sending a break to an 
Aquadopp Profiler in Data acquisition mode will produce a response from 
the instrument, but the data acquisition itself will be unaffected. The purpose 
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CHAPTER 4
Functional Description

Basic concepts. The Aquadopp 
Profiler measures the current in 
a set of cells along each beam 
to obtain the current profiles as 
shown in this simplified drawing. 
For clarity, only five cells are 
shown for each beam. The fact 
that the cells overlap each other 
has also been left out.
Theoretically, there can be up to 
128 cells per beam, but in real 
applications this will be limited by 
the range of the beams and the 
highest resolution (i.e. smallest 
cell size) permissible.
The blanking is the time during 
which no measurement takes 
place, essentially to give the 
transducers time to settle after 
having emitted a pulse (the 
transducers are used as both 
transmitters and receivers). 

of this design is to protect the system from stopping after an accidental break. 
To bring the acquisition to a halt, you will need to confirm the break. 

	 People using the Aquadopp Profiler with an external data logger (or similar 
devices) may want to know that if the measurement has been started using 
the low level command AD in lieu of ST, a confirmation will not be needed to 
halt the system after a break. 

	 This and other features of the low level command control system is described 
in the Paradopp Interface manual, which is available separately – contact the 
factory for details.

•	 Power down mode. The Power down mode saves power during deployments 
and prevents your battery from dissipating between deployments. The Aqu
adopp Profiler automatically powers down from Command mode after about 
five minutes of inactivity. 

	 To conserve your battery when the Aquadopp Profiler is on the shelf, be sure 
it is not in Data acquisition mode. Stop data collection using one of the Stop 
buttons before you store your Aquadopp.

Blanking 
distance

Measurement  
cells are shown  
non-overlapping  
for clarity

Blanking
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Using the Doppler Effect 
Tip! A tutorial providing insight 
in Doppler measurement basics 
can be found at  
http://www.nortekusa.com/
principles.html

	 You hear the Doppler effect whenever a train passes by—the change in pitch 
you hear tells you how fast the train is moving. The Aquadopp Profiler uses 
the Doppler effect to measure current velocity by transmitting a short pulse of 
sound, listening to its echo and measuring the change in pitch or frequency of 
the echo. 

There are many ways to measure the Doppler effect, each with its own advantag-
es and drawbacks. Nortek implements a narrow band auto covariance method, 
because this has been established as robust, reliable and accurate. 

Sound does not reflect from the water itself, but rather from particles suspended 
in the water. These particles are typically zoo plankton or suspended sediment. 
Long experience with Doppler current sensors tells us that the small particles 
the Aquadopp Profiler sees move on average at the same speed as the water—the 
velocity it measures is the velocity of the water.

The cells overlap. The Aqua-
dopp Profiler applies triangular 
weighting to each measurement 
cell as indicated along the beam. 
The baseline of the weighting 
function is twice the nominal cell 
size. About 75% of the acoustic 
return energy comes from the 
nominal  sampling volume.
Note how the cells overlap each 
other along the beam. 

Cell No. 1

Cell No. 3

Cell No. 5

Cell No. 7

Cell No. 9

Cell No. 11

Cell No. 13

Cell No. 15

Cell No. 17

Cell No. 2

Cell No. 4

Cell No. 6

Cell No. 8

Cell No. 10

Cell No. 12

Cell No. 14

Cell No. 16

Cell No. 18

Blanking 
distance

Triangular 
weighting 
function
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Doppler Beams
Doppler current sensors use large transducers (relative to the wavelength of the 
sound) to obtain narrow acoustic beams. For example, the 2 MHz Aquadopp 
Profiler has a beam width of 1.7°. Narrow beams are essential for obtaining good 
data. 

Each beam measures velocity parallel to the beam and does not sense the veloc-
ity perpendicular to the beam at all. The Aquadopp Profiler senses the full 3D 
velocity with three beams, all pointing in different directions. If you assume 
the flow is uniform across the three beams, simple trigonometry is sufficient to 
compute the velocity in any direction. The Aquadopp Profiler will still provide a 
good measurement in a non-uniform flow if the horizontal variations are linear.

The measurement cell is shaped like a triangle (as indicated in the Fig. on the 
previous page). The maximum extent of the weighting function is twice the 
length of the transmit pulse.

Coordinate Systems
The Aquadopp Profiler measures velocity components parallel to its three 
beams, i.e. in Beam coordinates, but it reports data in East, North and Up or 
ENU coordinates. To get to ENU components, it first converts the data to XYZ 
coordinates, an orthogonal coordinate system relative to the Aquadopp Profiler. 
The instrument then uses its magnetometer and tilt measurements to convert this 
velocity to components relative to the earth, or ENU coordinates. 

The coordinate systems are defined as follows:

•	 In Beam coordinates, a positive velocity along beam 1 goes in the direction 
towards which the beam 1 points. See the right Fig for beam definitions.

•	 In XYZ coordinates, a positive velocity in the X-direction goes in the direc-
tion of the X-axis arrow. 

•	 In ENU coordinates, a positive east velocity goes toward east.

Attitude Correction
Typical moorings allow the Aquadopp Profiler to tilt and rotate freely. It meas-
ures tilt and heading and uses this compass information to convert the data to 
true earth coordinates. How often the instrument reads the tilt and heading de-
pends on the deployment setup used. 

As is explained in Chapter 6—Operation,  the AquaPro software allows you to 
either use one of a series of predefined deployment setups, or to create your own 
setup.  

The predefined setups provide a compass-reading frequency reflecting the ap-
plication. For example, in a near-surface mooring the instrument will read the 
magnetometer and the tilt more often than it would on a fixed bottom mount.

CHAPTER 4
Functional Description
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Beam direction. In beam 
coordinates, a positive velocity 

along beam 1 goes in the 
direction towards which the 

beam 1 points.

1

3 2
3

1

231

2 3

XYZ direction. The Aquadopp 
Profiler XYZ direction varies 

with the head configuration as 
shown here. The leftmost and 
the rightmost units both have 
an X engraved to show the X-

direction. See also Coordinate 
Systems for details. Z

Z

X

X

Z

Y

Y

Y

X
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Because the magnetometer uses energy, the Aquadopp Profiler reads heading 
only as often as it needs to. This trade-off between power consumption and the 
need for accuracy is well taken care of in the predefined deployment setups. We 
therefore recommend that you stick to the predefined compass update rates (as 
they appear when you select a deployment environment) when creating your 
own deployment setup, unless you have good reasons for doing otherwise.

Velocity Uncertainty 
The recorded velocity is an average of many velocity estimates (called pings). The 
uncertainty of each ping is dominated by the short-term error. We reduce the 
measurement uncertainty by averaging many pings together. There is a limit to 
how much you can reduce your uncertainty. We call this limit the long-term bias. 

Note: The AquaPro software 
predicts the instrumental 
error only. In many situations, 
environmental turbulence will 
dominate the short term velocity 
fluctuations. 	 The long-term bias depends on internal signal processing, the filters, and the 

beam geometry. The long-term bias in the Aquadopp Profiler is typically a frac-
tion of 1 cm/s. The AquaPro software predicts errors based on the short-term 
error of a single ping and the number of pings averaged together. The short term 
error of a single ping depends on the size of the transmit pulse and the meas-
urement volume, and it depends on the beam geometry. Velocity components 
parallel to the acoustic beams will have smaller short-term errors than velocity 
components at a steep angle relative to the acoustic beams. Averaging multiple 
pings reduces errors according to the formula:

Vmean= Vping

           N

in which  is the standard deviation and N is the number pings you average 
together.

In turbulent flow such as boundary layers, your data collection strategy should 
take into account the nature and the time scales of the environmental fluctua-
tions. A rough rule of thumb in boundary layers is that the rms turbulent velocity 
is 10 % of the mean velocity. If, for example, your mean velocity is 1 m/s, you 
could estimate turbulent fluctuations to be 10 cm/s. Obtaining 1 cm/s rms uncer-
tainty would require at least 100 pings.

Measuring Waves
Tip! Tutorial articles on wave 
measurements using the PUV 
method can be found at  
http://www.nortekusa.com/
principles/Waves.html#PUV

	 The Aquadopp Profiler may also be used to measure waves using the PUV meth-
od. However, it is important to remember that the Aquadopp Profiler collects raw 
wave data. Therefore the data, by inspection, may not be entirely meaningful. 
This raw data must go through a processing step before it can be used to inter-

CHAPTER 4
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pret the waves on the surface. The processing will lead to classic wave estimates 
for height, period, and direction. Unlike the current profile estimates the wave 
processing is quite complex. The Nortek software programs QuickWave or 
Storm (available separately) can be used for this post processing.

The Aquadopp Profiler measures the pressure and two horizontal velocity com-
ponents when used in wave mode.

The data record of the raw signal will not provide a clear view of the wave environ-
ment on the surface. For instance, the pressure record is an attenuated version of the 
free surface. The attenuation depends upon the Aquadopp Profiler’s deployment depth 
as well as the surface wave frequencies. Therefore this data record is not going to be 
particularly useful until processing is performed. This is similarly true of the orbital 
velocity measurements. In fact, the orbital velocities will often appear noisy, and a 
sinusoidal wave pattern can sometimes be difficult to observe when waves are short 
in period.
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CHAPTER 5
Preparing the Instrumentation
We strongly advise that you check the shipment upon arrival. The below photo 
shows the contents of a standard shipment. The type of communication cable 
supplied depends on the type of communication (RS 232 or RS 422) ordered.

Optional RS 422 cable 
including RS 422-to-RS 232 
converter and  
RS 232 cable

Aquadopp 
Profiler

Battery

Power supply & mains cable

Tool kit
RS 232 cable

User Guide

AquaPro  
software

The contents of a standard ship-
ment. Every effort has been 
made to ensure that the shipment 
is in accordance with your order. 
However, as a precaution we 
recommend that you examine the 
shipment carefully before head-
ing to the deployment site. In the 
unlikely event of discrepancies, 
kindly report these to the factory 
immediately.

Shipping box
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Connecting the Battery


Use a CRT monitor and not an 
LCD monitor when degaussing 
alkaline batteries.

	 The Aquadopp Profiler is shipped with a battery pack installed in the pressure 
case, but disconnected. 

As a general precaution, alkaline batteries should always be degaussed before 
you use them in your instruments—you can do this yourself by placing the pad-
ded end of the battery up against the centre of your PC monitor (CRTs, not LCD 
screens) and using the monitor’s degaussing function. The purpose of this is to 
minimise any effect on the compass.

Always be sure to include desiccant in the pressure case. Humid air, trapped 
inside the canister can condense enough water to damage the electrical circuitry 
when the instrument is deployed in cold waters.

To connect the battery pack:

1	 Remove the four screws (1) and washers holding the end cap to the pressure 
case and remove the end cap.

2	 Pull the battery out of the pressure case (2).

3	 Connect the battery to the 2-pin connector (3) and re-insert.

4	 Insert the end cap to the pressure case and mount the four screws and wash-
ers. Tighten the screws carefully to avoid damaging the threads in the pres-
sure case. Tighten the screws only until the end-cap touches the pressure case 
(typically a torque of 2–3 Nm) and you can just feel that they are seated. Keep 
in mind that ocean pressure holds the end cap in tightly—all the screws have 
to do is to seat the o-rings properly and keep the end cap from falling out 
when the system is above water.

Connecting the batteries

CHAPTER 5
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Installing the AquaPro software on a PC 
The AquaPro CD contains everything you need to install and run the Nortek 
AquaPro application and has been designed for computers running Microsoft® 
Windows® 2000 and Windows® XP. You must install the application from the CD 
onto your hard disk; you cannot run the program from the CD.

Installing the program:

1	 Insert the AquaPro CD. Browse to the AquaPro program folder and locate the 
file Setup.exe. 

2	 Double-click Setup.exe and follow the on-screen instructions.

Running the AquaPro Program
You start the Nortek AquaPro just as you would start any software application:

 •	 Click Start > Programs > Nortek > AquaPro.

If you installed the program in a folder different from the default setting (default 
folder name is Nortek), substitute accordingly in the above setting.

Resources Available to Get You Started
The following resources are at your disposal to get you up and going:

 •	 This manual, which also is accessible from within the program.

 •	 The on-line help, which also contains a context sensitive help section.

 •	 Nortek on the world wide web for updates and technical support (see details 
on page 4 of this user guide).

 •	 The Nortek Forum (see details on page 4 of this user guide).

Running a Functionality Test
	 To run a functionality test:

1	 Plug in the AC adaptor and connect the Aquadopp to the PC serial port. Start 
the AquaPro program.

2	 Select Serial Port from the Communication menu to specify the port number 
to use:
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Setting up the serial 
communication.

3	 Accept the default baud rate settings (9600 baud), which is also the default 
instrument baud rate.

4	 Check the instrument communication and verify that the instrument is alive by 
activating the Terminal Emulator window and press the Send Break button to 
send a BREAK signal over the serial port. 

The terminal emulator

	

	 A break causes the instrument to report an identification string (see also side 
bar discussing the Break command) unless it is in Data acquisition mode when 
the break is received. In the latter case the instrument will respond with 

¶  C o n f i r m ?

CHAPTER 5
Preparing the Instrumentation



Aquadopp CURRENT PROFILER
User Guide

31

Doc. No: N3009-103 • Revision C • 01.2008

Tip: The best way to hold 
an Aquadopp to a fixed 
structure is to clamp it 
around its circumference.

A few words on the Break command
The Break is used to interrupt the instruments regardless of what mode they 
are in. It is frequently used in the communication with the instrument.

Traditionally, sending a break was done by holding the transmit line high on 
the serial line for a period of 500 ms. This is what we refer to as hard break. 
This works fine if you have a direct connection between your PC and the 
instrument. But once you use something else, for example a modem, you 
may get into trouble. The problem is that different types of modems handle 
hard breaks in their own way. Certain GSM modems will, for example, accept 
a 500 ms hard break on the input, but they will only output a 100 ms hard 
break, which will may not be accepted as a break in the instrument. 
 
To cope with problems like these, our instruments therefore offer soft break 
as default. The soft break consists entirely of characters, so it can be used 
with any device capable of RS232 or RS422 communication. 
 
With two types of break and one version of the communication software you 
will get communication problems if the software is set up with the wrong type 
of break. 

The easiest way to circumvent this problem is to use the auto detection 
feature in the software. Make sure you have chosen the correct serial port 
and press the Stop Data Collection button on the toolbar. The software will 
then find the correct communication baud rate and break type for you. 

	 and expect the MC command to accept the break and suspend its ongoing activi-
ties. When on the other hand this is done from the AquaPro software the instru-
ment will prompt you to confirm your intention of suspending its activities.

	 Close the terminal emulator upon successful communication. If unsuccessful, 
check battery, cabling, and COM port.

5	 Check the noise level of the instrument by selecting Deployment > Planning 
> Use existing to produce the below dialogue box. Set the Profile interval (s) 
to 1 second as shown, and click OK. Then click “Online > Start Data Collec-
tion” or the corresponding icon.
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Setting the profile interval to  
1 second

	 Keep the Aquadopp Profiler out of water. This pinging in air should produce 
a signal strength (Amplitude) of 20–30 counts (2 MHz version), 25–35 counts 
(1 MHz version), 30–40 counts (600 kHz version) and 20-40 counts (400 kHz) 
version. The signal level thus obtained is called the noise floor. When the in-
strument pings in air, the velocity measurements will be nothing but noise. 

Screenshot taken from a PC 
running Windows® XP, showing 
pinging in air (and consequently 
the noise floor). If you haven’t 
set the date in your Aquadopp 
yet, it will show a date from the 
year 2000.

Be sure to select Amplitude in 
the bottom line of the display as 
indicated in the Fig.

	 Put the instrument in a bucket of water and observe the signal strength and 
the velocity. The signal strength should rise noticeably (the actual level de-
pends on the size, shape and material of the bucket), and the velocity data 
should appear less noisy.
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6	 Check sensor readings:
 •		 Tilt and rotate the Aquadopp Profiler to verify that the readings make 

sense (see Verifying the Internal Sensors later in this chapter for details).
 •		 Check the temperature as measured by the Aquadopp Profiler. This should 

be close to your room temperature, assuming the Aquadopp Profiler has 
been in the room for a while. In case of incorrect temperature measure-
ments. You may have to correct this. (see Verifying the Internal Sensors 
later in this chapter for details).

 •		 Calibrate the compass, if applicable. This is particularly important to do 
if the instrument is to be deployed near magnetic structures (typically 
frames or other structures containing magnetic material. Observe that the 
compass calibration must take place in-situ (i.e. mounted in the frame) to 
take the frame’s magnetic effects into account. The procedure is described 
in Verifying the Internal Sensors later in this chapter.

 •		 Pressure should be near zero. Check the pressure sensor in a bucket 50 cm 
deep, or put your mouth over the pressure sensor and blow to create a 
pressure of around 50–150 cm. You may want to insert a pressure offset 
to align the depth indication to other measurement gear used or to com-
pensate for the ambient pressure. More on this is found in  Verifying the 
Internal Sensors later in this chapter.

		  If the Pressure Sensor Seems to Fail. If you are running older versions 
(prior to version 1.24) of AquaPro, you may experience that the pressure 
sensor output zero at all times. 

		  This may typically take place if the ambient pressure by the time of test-
ing is significantly lower than it was by the time the pressure sensor was 
calibrated. 

		  Internally, the instrument will note that the pressure now is negative and 
that will be reported as being zero (negative values are always reported as 
zero). 

		  To circumvent this (for AquaPro versions prior to v. 1.24 ) you should 
add 10 m as a pressure offset (see  Verifying the Internal Sensors later in 
this chapter) before submerging. The AquaPro software will then report a 
positive pressure value and you will be able to confirm that the pressure 
changes accordingly as you submerge the transducer head. 

		  From AquaPro v. 1.24 and onwards, this is taken care of internally. If a 
negative pressure is detected, the AquaPro itself adds an offset to the 
pressure and a second attempt is made automatically. As a user you will 
then see that the pressure increases correctly as the transducer head is 
submerged.

 •		 Battery voltage shall be greater than 13 VDC (new battery).
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Test the Recorder Function
Note: If you leave the 
Aquadopp Profiler collecting 
data, it will continue to run 
until the batteries are dead. 
Always make sure to stop 
data collection when testing 
is complete. This puts the 
Aquadopp into command 
mode and it will then enter 
into a sleep state (the lowest 
possible power) after 5 
minutes of inactivity.

	 You can test the recorder with the same setup as the above. Do as follows:

1	 Start data collection with Online followed by Start With Recorder.
2	 Write a name to use for the file you will record internally.
3	 After a few minutes, stop the data collection.
4	 Retrieve your data by clicking Deployment > Retrieve Data.
5	 Convert it to ASCII by clicking Deployment > Data Conversion.
6	 Review the collected data with an ASCII text editor (i.e. Notepad).

Starting with an Empty Memory
To erase the Aquadopp Profiler’s contents of data:

1	 Make sure that any data you want to retain are transferred to your computer 
(if applicable) and that the data is in good shape.

2	 Click Deployment > Erase Recorder.

Verifying the Internal Sensors
The Aquadopp Profiler has four sensors that should be checked regularly to 
verify their performance. These are the tilt sensor, the temperature sensor, the 
pressure sensor, and the compass. It is of great importance to check and calibrate 
the compass. The compass is sensitive to all magnetic fields, not only the earth’s. 
Hence magnetic material used in the mooring may bias the compass readings 
significantly.

Calibrating the Temperature Sensor
The temperature sensor is calibrated using a very accurate temperature refer-
ence source before the instrument leaves the factory. Hence, we recommend that 
you start by checking the temperature sensor’s performance by comparing its 
reading to that of a precision thermometer. If a significant deviation is revealed, 
you should consider to proceed as described below.

To calibrate the temperature sensor:

1	 Make sure the Aquadopp Profiler is connected to the computer and let it be 
exposed to a constant temperature for more than 15 minutes to stabilize the 
temperature readings from the instrument.

CHAPTER 5
Preparing the Instrumentation
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2	 Click Online > Temperature Calibration

3	 Use a thermometer with sufficient precision for your task to read the ambient 
temperature and key in this temperature in the Aquadopp dialogue box.

4	 Follow the online instructions.

Temperature calibration. 
Click On-line > Temperature 
calibration to produce this 
display and enter the ambient 
temperature. Make sure the 
Aquadopp temperature readings 
have stabilized – see text for 
details.

Verifying the Tilt Sensor
To verify the tilt sensor:

1	 While the Aquadopp Profiler is connected to the computer, place it level on a flat 
surface.

2	 In the main screen inspect the heading, pitch, and roll readings. 



36

Doc. No: N3009-103 • Revision C • 01.2008 

CHAPTER 5
Preparing the Instrumentation

Tilt sensor verification. Click 
the Sensors tab in the numerical 
tab part of the main screen and 
verify that the tilt readings make 
sense. In case of significant 
deviations, contact the factory.

Setting the Pressure Sensor Offset

Tip! See also Running a 
Functionality Check – item 6, 
in this chapter of the manual.

	 To calibrate the pressure sensor:

1	 Have the Aquadopp Profiler connected to the computer and submerge the 
Aquadopp Profiler in water.

2	 Click On-line > Set Pressure Offset and key in the depth in m. If you want 
to introduce an offset to e.g. use a common reference for your entire instru-
mentation on a deployment site. Note that the pressure sensor will not output 
negative values, and we recommend that you give the pressure sensor a posi-
tive offset.

The dialogue box for setting the 
pressure offset  – see text for 
more. Observe that atmospheric 
changes can vary the depth 
reading as much as 0.3 m!

Calibrating the Compass
The compass calibration is designed to adjust for magnetic materials that may be 
present in your deployment frame or mooring structure. As a consequence, cali-
bration of the compass should take place after the Aquadopp Profiler has been 
mounted in its frame or mooring. Be sure to mount all other equipment and ma-
terials that is to be attached to the frame or mooring and conduct the procedure 
outdoors, away from other possible magnetic elements. 
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To calibrate the compass, do as follows:

1	 Assemble the frame or mooring structure completely, with Aquadopp Profiler 
mounted, be sure to include any external battery canisters (if applicable), and 
the extra ballast needed to create a stable structure. Connect the Aquadopp 
profiler to the computer as usual.

2	 Make sure it is possible to rotate the entire system (instrument + frame/
mooring, including any extra equipment) 360° around the instrument’s z-axis. 
For a definition of the z-axis, turn to Chapter 4—Functional Description.

3	 Click On-line > Compass Calibration. This will produce the following dia-
logue box:

The Compass Calibration 
dialogue box.

4	 Click Start and rotate the entire system slowly 360° around the z-axis of the 
Aquadopp Profiler. An example of successful rotation is shown below.

5	 To make use of the obtained values, click Done. You will be prompted to 
confirm that the new values shall be transferred to the Aquadopp to serve as 
the new compass setting.

Rotate the entire system slowly 
around the z-axis of the Aquadopp 
Profiler. Turn to Chapter 4 for a 
definition of the z-axis.
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The Compass Calibration dia-
logue box after a successful cali-
bration has been made.

When doing this in-situ with the 
Aquadopp mounted in a heavy 
mooring structure, you cannot 
expect to end up with a circle as 
perfect as this one. However, we 
recommend you to do this slowly 
in an attempt to come as close to 
the ideal circle as possible. 

The estimated maximum error 
after calibration is the estimated 
error resulting from non-horizon-
tal rotation (oblique circle).

Upgrading the Firmware
By the term firmware we are referring to the internal software of the Aquadopp 
Profiler, as opposed to the AquaPro software running on a PC and described in 
this manual.

When you purchase a brand new Aquadopp Profiler from the factory, it has a 
firmware version matching the PC software. Hence no firmware upgrade will be 
needed before you start using your Aquadopp Profiler.

However, new functionality (and in rare cases bugfixes) is likely to be offered in 
the future, requiring that the firmware is upgraded. New firmware is posted on 
our web site at http://www.nortek-as.com/support.php. You will need to register 
to get access, but access is otherwise free of charge.

To do a firmware upgrade:

1	 Go to http://www.nortek-as.com/support.php, register if this is the first time, 
otherwise just log into the User Room, click on Software & Firmware and 
download the new firmware file to your computer (save it).

2 	 Make sure your Aquadopp Profiler is connected to the computer and that they 
communicates well together.

3	 Click on Configuration > Firmware Upgrade in the AquaPro software, 
browse to the downloaded firmware file and select it.

CHAPTER 5
Preparing the Instrumentation
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This will produce the following dialogue box:
Firmware upgrade in progress

To ensure that the Aquadopp Profiler firmware avoids becoming corrupted 
because the download transmission failed during the download process, the 
Aquadopp runs a check on the received file before it is allowed to replace the 
existing firmware. 

Once verified as valid, the following dialogue box will appear …
The instrument warns you 
that any data acquired in the 
Aquadopp Profiler will be erased 
to avoid inconsistencies

… just to warn you that any data residing in the Aquadopp Profiler will be 
erased to avoid inconsistencies. In other words, transfer data that you would 
like to retain to your PC before you upgrade the firmware.

Mounting Guidelines
	 The Aquadopp Profiler is often used in areas with large waves. Large waves gen-

erate strong orbital currents, which again means that the mounting frame will be 
subject to strong forces. To survive the wave forces the mounting frame should 
be compact at the same time as it should be heavy. Contact Nortek if you need 
ideas on what the mounting frame should look like.

The Aquadopp Profiler has been designed for easy mounting and 
deployment. The following guidelines should give you the best possible 
data:

•	 When mounting the Aquadopp Profiler near large obstructions (bridges, 
piers, walls, etc.), ensure that the acoustic beams do not “see” any obstruc-
tions. Objects interfering with the beams may damage or destroy your data. 
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•	 Keep the Aquadopp Profiler away from magnetic materials. 

•	 Consider the frame or cable holding the Aquadopp Profiler, and the structure 
it is mounted on. Nearby magnetic materials could cause the directional read-
ings to be in error.

•	 Consider the effects large objects will have on the flow itself. A rough rule of 
thumb is that objects disturb the flow as far as 10 diameters away from the 
object. Flow disturbance is greatest directly downstream in the wake behind 
the object. Flow disturbance affects your measurements by changing the flow 
and by making it non-uniform across the Aquadopp Profiler’s beams. 

•	 All acoustic transducers must be submerged during data collection. Operat-
ing with the transducers out of water will not cause damage, but your data 
will be meaningless.

•	 The pressure sensor can handle pressure that is about 150% of its maximum reading. 
For example, the standard 100 m pressure sensor can safely withstand 150 m depth.

Using Long Cables
RS232 data communication at 9600 baud will normally work fine for cables up 
to 50 m long, depending on the environment.

If you want to run a longer cable, you can switch to RS 422 by installing a differ-
ent wiring harness you can get from Nortek. 

You can also try using RS 232 with longer cables by reducing the baud rate. Keep 
in mind that RS 422 is a more reliable means of communication than RS 232—
changing environmental conditions could cause RS 232 communications to fail 
over a long wire without apparent reason. 

You should consider the voltage drop across the cable, particularly if you use the 
two highest power settings (see Deployment planning in Chapter 6—Operation 
for details on this). Design your power supply and cable so that the voltage stays 
below 16 VDC, and never falls below 9 VDC.

Changing the Baud Rate
You may specify two separate baud rates for the Aquadopp Profiler. The primary 
baud rate setting applies to normal communication and data transfer. You can also 
set a secondary baud rate for data download and firmware upgrades (the Recorder/
Configuration baud rate). A higher baud rate speeds up large file transfers and 
is appropriate when you have a short serial cable and a relatively noise-free envi
ronment.
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Note! The Aquadopp software 
will not enable diagnostics data 
if there is not sufficient time 
between normal data collection 
cycles to enable the Aquadopp to 
collect the diagnostic data.

The standard baud rate is 9600, and we recommend that you use this baud rate 
unless you have a good reason to change it. 

Note! If data download is 
interrupted the Aquadopp Profiler 
may be left with a baud rate 
setting other than the one used 
for normal communication. When 
the software tries to establish 
communication in such cases, 
it may spend a few moments 
searching for the current baud 
rate.

	 To change the baud rate and make it permanent, do the following:

1	 Set up the Aquadopp Profiler and connect it to your computer.

2	Set the baud rate in Communication > Serial Port to the baud rate you prefer. 
Start a deployment, and then stop it. The last step makes the new baud rate 
permanent. If you remove power and reapply it, the Aquadopp  Profiler will 
re-awake with the new baud rate.
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CHAPTER 6
Operation
The AquaPro program has been designed to aid your planning, execution, recov-
ery and processing of autonomous Aquadopp Profiler deployments. However, 
the AquaPro program can also be used to control the instrument in real time 
applications. Real time applications are covered in Chapter 7—Real Time Ap-
plications. How to install the AquaPro software is described in Chapter 5—Pre-
paring the Instrumentation.

This chapter provides a detailed description of the use of the AquaPro program 
for autonomous deployment setups.

Data CollectionTip! You can easily use 
a radio to check that the 
Aquadopp Profiler is running. 
The Aquadopp Profiler 
transmits energy at 0.4, 0.6, 1, 
or 2 MHz, and an AM radio will 
pick up these signals or their 
harmonics. Be sure to listen 
first with the Aquadopp Profiler 
on the bench to choose the 
best frequency and to learn 
to identify the Aquadopp’s 
distinctive sounds. 

If you would like to listen to 
examples, go to our Forum 
and search for “verifying 
pinging”. See page 4 for details 
on the use of our Forum.

	 The Aquadopp Profiler system allows for both self-recording and real-time data 
collection. 

A typical sequence includes:

1	 Install and/or plug in battery pack. Refer to procedure in Chapter 6. 
2	 Install new desiccant, if necessary. Refer to procedure in Chapter 6. 
3	 Test the Aquadopp Profiler according to procedure in Chapter 4.
4	 Set PC time.
5	 Use AquaPro software to plan deployment. Click Deployment > Planning.
6	 Erase recorder. Click Deployment > Erase Recorder.
7	 Start deployment. Click Deployment > Start Recorder Deployment.
8	 Enter a 6-character deployment name.
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A Tour of the AquaPro Desktop 

Save  
file
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a new  

file

Open an 
existing 

file

Create a 
printout

Deployment 
planning

Start  
recorder  

deployment

Stop  
recorder  

deployment

Recorder 
data  

retrieval

Data  
conversion

Start 
data  

collection

Start 
recorder 

data  
collection

Stop 
data  

collection

Stop 
disk  

recording

Start 
disk  

recording

Help

About this 
program

Title bar and menu bar

Icon bar

Display control bar

Data display selection bar

Numerical display. Contents 
is determined by the Display 
control bar setting.

Graphical display. Contents 
is determined by the Data 
display selection bar 
setting.
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The AquaPro Pull-down Menus

The File menu lets you create new 
deployments, open existing ones as 
well as saving files. This menu also 
lets you print out your graphs and 
tables as well giving you shortcut 
access to recently used files.

The Communication menu is used 
to set up the serial communication 
and to start the Terminal Emulator.

The Deployment menu lets you 
define a deployment regime, start 
and stop recorder deployment, view 
a log on what’s been taking place, 
retrieve recorded data, convert the 
acquired data to ASCII format, and 
erase the recorder contents.

The View menu lets you beef up 
the display to your liking. 

The Configuration menu is used 
to upgrade the firmware to a more 
recent version and to upgrade the 
head configuration file, whenever 
applicable.

The On-line menu is used to 
start and stop data collection with 
or without the internal recorder, 
as well as to define a file name 
for the recording to a remote 
computer’s hard disk and to start 
that recording. In addition this menu 
lets you set the clock, the pressure 
offset and calibrate compass and 
temperature.

The Help menu provides access 
to Help topics as well as an on-line 
version of this manual and program 
version information. 
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9	 Set Aquadopp time to PC time.
10	If appropriate, set a delayed start-up time.
11	Disconnect cable and install dummy plug.
12	Verify pinging with AM radio just prior to deployment.
13	Install on site. Ensure the acoustic beams point where you want and that they 

are not obstructed.

Deployment Planning
On the main menu, select Planning from the Deployment pull-down menu or 
press the Deployment Planning toolbar button to activate the planning dialogue 
box. The Planning submenu displays three options that may serve as a starting 
point for your deployment planning.

Producing the Deployment 
Planning menu.

•	 Select Use Existing to start with the previous settings  
(This selection corresponds to the Deployment Planning toolbar button).

•	 Select Load From File to read settings from a deployment (.dep) file.
•	 Select Load From Instrument to read settings from the instrument.

The Deployment planning 
pane shows the consequences 
of your setup choices in terms 
of battery utilization, memory 
requirements, and velocity 
precision.

	 The Deployment planning menu contains all parameters required to specify the 
operation of the instrument. For convenience, the dialogue is tabbed, consisting 
of a Standard tab and an Advanced tab.  

The Standard tab lets you input main settings like profile interval, number of 
cells and cell size along with typical mounting and the environment (coastal wa-
ter, river, deep water, and open ocean). Based on your settings the program will 
choose a set of default settings for the deployment.

If you want more control of the deployment setup, click the Use advanced set-
tings, go to the Advanced tab and refine your setup. Remember to click on Update 
from Standard to refresh the settings already made to avoid visual inconsistency.

The Deployment planning pane (the right part of the dialogue box—see Fig.) 
displays performance parameters that are automatically updated as you change 
the parameter settings. When finished, press OK to accept the changes. 

CHAPTER 6
Operation
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The Deployment Planning Menu 
Standard tab

Frequency. Choose 600 kHz, 
1 MHz or 2 MHz depending the 
frequency of your instrument.

This is the 
Standard tab

Mounting. Choose the setting 
that best fits your deployment. 
Moving buoy and Mooring 
line mounting requires more 
frequent compass reading 
and hence more battery 
power spent. To see the 
consequence, watch the effect 
on battery utilization.

Profile interval 
is the time 
between each 
measurement, i.e. 
the data output 
rate.

Number of cells 
is the number of 
current measuring 
cells along each 
beam.

Cell size is the 
length of each cell 
along the beams.

If the default settings fail 
to provide the deployment 
setup control you need, you 
should use the Advanced 
settings. Check this box 
for Advanced setting to 
become effective.

Environment. Choose the setting 
that best fits your deployment. The 
setting determines the instrument 
transmit level. To see the conse-
quence, watch the effect on battery 
utilization.
Because coastal waters and rivers 
normally have high backscatter, 
these choices reduce transmit 
power (and hence battery utiliza-
tion). If you are working in such 
areas, but still know you have low 
backscatter, select Deep water or 
Open ocean instead.

Click OK to leave menu put-
ting changes into effect.
Click Cancel to leave menu 
undoing any changes.
Click Apply to put changes 
into effect without leaving the 
menu.
Click Help to start the context 
sensitive Help system.

The Standard tab provides 
convenient default settings 
for typical environments and 
mounting arrangements.

Deployment planning. Enter the 
number of days you intend to collect 
data. This value will, together with 
the other deployment parameters 
and the hardware configuration, be 
used to calculate the performance 
parameters and hence the total 
battery utilization, recorder memory 
requirements and velocity precision 
(expressed as the standard deviation 
of the noise).

Default com-
pass update 
rate and power 
level to be 
used, unless 
you choose 
to activate the 
advanced set-
tings.
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The Deployment Planning Menu 
Advanced tab

Average interval 
is the time the in-
strument is actively 
measuring through 
the profile interval. 
The instrument will 
be in sleep mode 
during the rest of 
the profile interval. 

This is the 
Advanced tab

Blanking distance 
is the distance 
from the sensor to 
the start of the first 
measurement cell.

Compass update 
rate. Compass read-
ing consumes  
energy. It can be 
done every second, 
but you may also set 
it to a longer interval.

This part is 
similar the 
same of the 
Standard tab 
and explained 
there.

Refresh settings 
to reflect set-
tings made in the 
Standard tab. 

Wave bursts. 
Must be 
checked to 
collect veloc-
ity and pres-
sure data for 
wave spectra 
computations. 
See text for 
more on this.

Click OK to leave 
menu putting 
changes into ef-
fect.
Click Cancel to 
leave menu undo-
ing any changes.
Click Apply to put 
changes into ef-
fect without leav-
ing the menu.
Click Help to start 
the context sensi-
tive Help system.

The Advanced 
tab gives you 
detailed control 
of the setup when 
the default settings 
won’t suffice.

Coordinate 
system. Select 
ENU, XYZ or 
Beam (See 
Chapter 4 for more 
on this)

Power level. Sets the 
amount of acoustic 
energy emitted into the 
water. Level difference 
between High and low is 
20 dB, step size is about 
6  dB. Use high setting 
unless you are sure of 
high backscatter or only 
using short range.

File wrapping. 
When checked the 
internal recorder 
operates in ring-
buffer mode to 
ensure that it always 
holds the latest 
data. If unchecked 
data logging stops 
when the recorder 
is full.

Analogue inputs. The instru-
ment can read two analogue 
inputs at the same time. The 
inputs are typically used to con-
nect  a CT sensor to the system. 
You may specify when the 
sampling of the external sensor 
shall take place – during wave 
measurements, during profile 
measurements or during both.

Sound 
propagation 
speed Key in the 
salinity (to have the 
speed calculated 
based on salinity 
and temperature) 
or use a fixed 
sound speed. 
Salinity is typically 
35 in the ocean 
and 0 in fresh 
water.

Measurement load. 
The percentage of 
time  spent in Active 
(data collecting) mode 
per second. Uncheck 
Auto to gain manual 
control of this.
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	 Use the Open/Save commands in the File menu (or the corresponding toolbar 
buttons) to save the deployment parameters as a file at any given time. You may 
then reload it when it is time to actually deploy the instrument.

Wave Bursts
When collecting velocity and pressure data for wave spectra computations, ob-
serve that the instrument will not do profiling and wave burst measurements at 
the same time and that wave measurements are given priority (see Fig. below). 

Cell size can be 2–8 m for 600 kHz systems, 1–4 m for 1 MHz systems, and 
0.5–2 m for 2 MHz systems. The lower setting is recommended for shallow wa-
ter deployments only. Maximum recommended depth for wave burst measure-
ment is 20 m.

Number of samples can be 512, 1024 or 2048. The higher the number the better 
the estimate will be at the expense of increased time between profiler measure-
ments.

The Aquadopp Profiler measures 
profile and waves sequentially. In 
case of conflict, wave measure-
ments have priority over profile 
measurements. 

The ASCII conversion software 
can interpolate the missing pro-
file.

Sampling rate determines the length of the wave burst. Example: 2 Hz and 
1024 samples will cause the wave burst to take 512 seconds to do.

Interval is the time between each wave burst.
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Use with other Instruments
	 The Aquadopp Profiler comes with two analogue inputs to enable e.g. a CT 

sensor to be connected to your system. The instrument can read both analogue 
inputs at the same time. 

What are counts really? 
For signal strength, Nortek fre-
quently make use of the word 
counts, which obviously seem to 
be connected to the decibel term, 
but how and why?
Inside the Aquadopp profiler 
there are circuitries for the ampli-
fication of input signals. The num-
ber of counts is an indicator of 
how much gain we must apply to 
a signal – the less gain needed, 
the higher the input signal level is. 
The number of counts is inversely 
proportional to the logarithm of 
the gain setting, which means 
that a higher number of counts 
reflects a need for less amplifi-
cation than a lower number of 
counts will do.
Strong signals have a higher 
noise immunity and they cor-
relate much better than weak 
signals do.
For the Aquadopp signal pro-
cessing, 1 count ≈ 0.4– 0.45 dB. 
Observe that the term counts is 
also used in other contexts (viz. 
the analogue inputs) with a dif-
ferent relationship, not related to 
dB. Here 0 V equals 0 counts, 5 V 
equals 65535 counts, and 2.5 V 
equals 32768 counts (in other 
words a 16 bit system) 

	 The following should be observed:

•	 The Deployment planning menu is used to determine when to sample the 
external sensors. Choose between when measuring wave, when measuring 
profile or during both.

•	 The input impedance of the analogue inputs is 470 kΩ/100 nF.

•	 If you want to power the external sensor from the Aquadopp Profiler you 
must check the Output power box. The output power is configured in hard-
ware by Nortek and can be raw (i.e. battery power), +5 V, or +12 V. The raw 
setting is the default setting and all instruments come with this setting unless 
otherwise was specified upon ordering.

To activate powering of the external sensor from the Aquadopp Profiler:

1	 	 In the AquaPro software click Deployment > Planning > Use existing or 
use Load from Instrument. 

2		 Click Use Advanced and go to the Advanced tab.
3		 Define which analogue input (1, 2 or both) to use. Profile is used to sam-

ple data at the same rate as profile measurements are started, while Wave 
samples every time a wave burst measurement is started. The Profile & 
Wave is used to sample data every time a profile or a wave burst measure-
ment is started.  Only one of the inputs can be set to sample while wave 
measurements are made. A warning will appear if you attempt to set them 
both to wave related sampling.

4	  Check the Output power box.

•	 The data from the external sensor will not be affected by the Aquadopp Pro-
filer data quality. For example, the external sensor’s data will be totally unaf-
fected even if the Aquadopp Profiler is out of water and thus measuring noise 
only.

•	 No powering of the external sensor will take place when the Aquadopp Pro-
filer is in sleep mode. This helps reducing the system’s power consumption 
significantly.

	 Consequently, any external sensor used must be capable of automatically re-
suming its duties once the power comes back, and they must do this within 
1 sec after power up in order to provide correct data for the first sample.

•	 Our efforts to reduce the system’s power consumption includes a non-con-
stant sampling of the external sensor.
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You should note that when using an external sensor you will need to make 
your own calculations for power requirements and battery life. The Aquapro 
software is not able to do this when calculating battery utilization.

The input section of the Aquadopp’s analogue input looks like this:

The Aquadopp’s analogue input 
circuitry – see text for details on 
functionality.

To protect the Aquadopp circuitry against external sensors providing an output 
voltage in excess of +5.0V, there is a clamping diode on the input with a current 
limiting resistor in series. The diode will conduct at voltages above approxi-
mately 5.3V. 

To achieve stable conditions during testing, the +5V_SEN net can be powered up 
from command mode by sending the hex command 435001C4 from the terminal 
emulator.

•
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Starting Recorder Deployment
Before you start a deployment, either define a new deployment configuration 
(deployment planning) or load a saved configuration from memory. Then click 
Deployment > Start Recorder Deployment, and enter a short deployment name  
of no more than 6 characters, which will be used for the internal data file. The 
program allows you to set the Aquadopp Profiler’s internal clock (see below), 
and then gives you a final review on the instrument setup, just before you start 
it up. 

We urge you to verify that the battery level and available memory match your 
deployment setup.

The software creates a log file using your deployment name with the setup pa-
rameters. You should keep this file in your records.

Use a delayed startup either to make sure the Aquadopp Profiler starts data col-
lection on the hour, or to conserve batteries for a deployment that starts some 
time in the future. You can start an Aquadopp Profiler deployment well in ad-
vance of when you plan to install it on site, and use a delayed startup to conserve 
the Aquadopp Profiler’s battery and recording resources for the actual deploy-
ment.

Starting a recorder deployment.

Setting the Instrument’s Real Time Clock
The software allows you to set the Aquadopp Profiler time of day and a delayed 
startup time when you start the deployment (see above). The easiest way to 
set the Aquadopp Profiler time is to use the PC time setting. We recommend 
you to make sure the PC time is set correctly before you start the deployment. 
An important reason to set the correct time may be to synchronize a group of 
Aquadopps with one another or with other sensors. The real time clock of the 
Aquadopp Profiler has an accuracy of approximately ± 20 seconds per year 
which is far better than a typical PC clock. If you want to take advantage of the 
Aquadopp Profiler clock to keep data from several instruments synchronized, 
you may want to set the PC time with a GPS card.
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Setting the real time clock in the 
Aquadopp Profiler.

Stopping Recorder Deployment
Before you tell the Aquadopp Profiler to stop collecting data, verify that the 
computer time is accurate. The software will compare the computer time with 
the Aquadopp Profiler time, and you can use this information to quantify clock 
drifts. After you recover your Aquadopp, use the Aquadopp Profiler software to 
stop recording. After you connect the Aquadopp Profiler to your computer, click 
Deployment > Stop Recorder Deployment or click the corresponding icon.

When the program tells the Aquadopp to stop collecting data, it displays both the 
Aquadopp Profiler time and the computer time. We recommend that you keep 
a record of the differences, which can be used to correct the exact time of the 
Aquadopp samples—assuming that your PC clock is correct.

When you stop the deployment 
computer time and instrument 
time will both appear for 
comparison.
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CHAPTER 7
Real Time Applications
Autonomous deployments are by far the most common Aquadopp Profiler ap-
plication. However, you may just as well use it in real time applications. Such 
applications may, of course, be part of permanent or semi-permanent environ-
mental monitoring systems, but from time to time you may want to set up a real 
time system to test your application before you actually deploy the instrument. 
This chapter outlines the real time features of the AquaPro program. 

We recommend users with real time application requirements to check www.nortek.no 
regularly for new advances in our range of online software programs.

Online Solutions
For cables not longer than 50 m, RS 232 communication at 9 600 baud will nor-
mally work fine. If you want to run a longer cable,  you can switch to RS 422 by 
installing a different wiring harness, which can be obtained from Nortek. 

You can also try using RS 232 with longer cables by reducing the baud rate. Keep 
in mind that RS 422 is a more reliable means of communication than RS 232—
changing environmental conditions could cause RS 232 communications to fail 
over a long wire without apparent reason. 

You should consider the voltage drop across the cable, particularly if you use the 
two highest power settings (see Deployment planning in Chapter 6—Operation 
for details on this). Design your power supply and cable so that the voltage stays 
below 16 VDC, and never falls below 9 VDC.

Permanent online installations may include other communication solutions, 
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such as underwater modems, surface buoys, GSM modems and/or Iridium com-
munication. One example of such an installation is shown overleaf. 

Permanent real time installations of Aquadopp Profilers have a lot in common 
with real time installations using the Nortek AWAC. Examples of online solu-
tions can be found in our AWAC brochure, which can be downloaded from  
http://www.nortek-as.com/brochures/AWAC.pdf. Articles on the subject are also 
available at http://www.nortekusa.com.

See also Mounting Guidelines in Chapter 5 for tips on deployments.

An online (real time) application 
example. More on online 
solutions can be found on our 
web sites. See text for details.

Recording Data Internally as a Backup
You can set the instrument to record data internally while at the same time send-
ing data out the serial port. To do this, use Online > Start with recorder or click 
the corresponding icon.

If you have an internal backup battery, then you can record backup data in the 
event of power failures. 

The Aquadopp has two modes of internal recording. The standard mode is to stop 
recording when the recorder is full. The Aquadopp can also use a wrap-around 
mode in which it keeps only the most recent data, overwriting the oldest data 
when the recorder is full. Wrap-around data recording makes good sense when 
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you are backing up external recording against the possibility of power failures. 
This is set up in the Deployment planning menu (see Chapter 6 for details).

Online Viewing of Acquired Data
Online presentation of acquired data can be numerical (tabulated) as well as 
graphical. 

Display control bar

Data display selection bar

Numerical display. 
Contents is 
determined by the 
Display control bar 
setting.

Graphical display. 
Contents is 
determined by 
the Data display 
selection bar setting.

The two menu bars used for 
determining what to display

Numerical View Options
The numerical view options include tabulated presentations of the measured cur-
rent profiles, sensor information, system status, and system information.

The current tab provides a tabulation of the measured current profiles per cell, 
including the measured amplitudes indicating the received signal strength.
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The current tab provides a 
tabulation of the measured 
current profiles per cell and the 
measured amplitudes.

Cell No.

Distance 
[m] from the 
Aquadopp 
along the beam

The three velocity 
components shown 
in the coordinate 
system used

The amplitudes (in counts) for 
the three beams indicate the 
signal strength 

The sensors tab provides information about the sensor and the reading of the 
analogue inputs.

The Sensors tab provides 
information about the sensor 
and the reading of the analogue 
inputs.

Date & time of day 
when the measure-
ment viewed was 
started

Measured  
temperature

Sound speed  
as used in the 
measurement

The detected  
pressure

Battery voltage
Pitch, roll and 
heading of the 
Aquadopp

Signal levels (in counts) as  
detected at the analogue inputs  
(N/A = Not Applicable)

The status tab provides information on the path to the disk file and its size. Any 
errors occurring will be indicated here.
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The Status tab provides 
information on the disk file 
location and its size.

Date & time of day 
when the mea-
surement viewed 
was started

Disk file shows 
the name of the 
disk file in use for 
data recording. 
OFF is displayed 
when no data 
are stored to the 
computer disk 
during an online 
measurement

Current size of the file being  
recorded onto the computer’s  
hard disk

Error and status codes 
– see text for details

Error codes

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
Not 
used

Not 
used

Not 
used

Flash Tag bit Sensor 
data

Measurement 
data

Compass

0=OK 
1= Error

0=OK 
1= Error

0=OK 
1= Error

0=OK 
1= Error

0=OK 
1= Error

Status codes

Bit 7 & 6 Bit 5 & 4 Bit 3 Bit 2 Bit 1 Bit 0
Power level 
00 = 0 (high) 
01 = 1 
10 = 2 
11 = 3 (low)

Wakeup state 
00 = bad power 
01 = power applied 
10 = break 
11 = RTC alarm

Roll 
0 = OK 
1 = out 
of range

Pitch 
0 = OK 
1 = out 
of range

Scaling 
0 = mm/s 
1 = 0.1mm/s

Orientation 
0 = up 
1 = down

The system tab provides information on the system itself.

The System tab provides 
information about the system 
itself.

Date & time of day 
when the mea-
surement viewed 
was started

Disk file shows 
the name of the 
disk file in use for 
data recording. 
OFF is displayed 
when no data 
are stored to the 
computer disk 
during an online 
measurement

Current size of the file being  
recorded onto the computer’s  
hard disk

Error and status codes 
– see text for details
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Graphical View Setup Options
The graphical tabs determine what to display in the lower part of the AWAC soft-
ware main screen. By right-clicking the mouse whilst positioned in the graph 
area, you may customize the display.

Customizing the Display
To be able to customize the graphical display:

•	 Whilst positioned in the graph area, right-click the mouse. A context-sensi-
tive menu will now appear.

If you right-click the mouse 
 whilst in the graph area, a 
context-sensitive menu will 
appear.

To change the time scale:

 •	 In the context-sensitive menu, click the Scaling... or Scale/Data... The exact 
name and appearance of this submenu depends on the function displayed at 
the moment you right-clicked.  If Scaling appears ghosted, there is nothing 
to set for the function currently displayed.

The Scaling submenu comes in 
two flavours; with and without 
bin (cell) number specification. 
This choice appears only when 
meaningful. In addition, the 
scaling submenu lets you define 
the time span in seconds for 
level vs. time displays, and the 
data range (vertical axis setting). 
For profiles, the scaling refers to 
the levels and not to the distance 
span shown. You may also select 
autoscaling in some cases.
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To change the look of the graphs:

1	 In the context-sensitive menu, click the Customization... This will produce a 
tabbed dialogue box.

2	 Set the parameters as required for your application. Parameters are explained 
in the following.

The General Tab
The General tab of the graphical 
display Customization  
dialogue box.

Main Title & Sub Title. These two edit-boxes allow adding, editing, and deletion 
of main and sub titles. If no title is present, entering one will add one. If you re-
move all the characters from a title, the title will be deleted from the image.

Viewing Style. The graph supports three viewing styles:  

•	 Color
•	 Monochrome
•	 Monochrome with Symbols

This customization allows you to quickly adjust the image to best suit print-
ing on a monochrome printer. If fewer than four subsets are to be included in a 
graph, then the Monochrome setting will probably be the best choice.  If four or 
more subsets are to be included in the graph, then Monochrome with Symbols 
will help distinguish between the different subsets.

Font Size. The graph supports three font sizes, Large, Medium, and Small.  This 
gives you the option of selecting the font size that is most readable. When print-
ing the graph, a font size of Medium or Small is suggested.

Numeric precision. Defines the number decimals to be used when placing data 
labels onto the graph, and when exporting Text/Data via the Export Dialogue 
box.

Grid Lines. The graph can contain vertical grid lines, horizontal grid lines, both 
vertical and horizontal grid lines, or no grid lines. Grid lines can be made to ap-
pear in front of the graph.
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The Plot Tab
The Plot tab of the graphical 
display Customization  
dialogue box.

Axes: Lists the axes available for customization (context-sensitive – depends on 
function viewed when this menu was entered).

Plot Style. The AquaPro software supports a multitude of plotting methods. 
Depending on the implementation, some plotting methods may not be available. 
Also, many but not all of these plotting styles can be set for a secondary com-
parison plotting style.

If the graph has multiple y-axes, you can control plotting styles for each indi-
vidual axis by selecting the axis in the axis-button group.

3D. This feature allows you to add three-dimensional effects to the plots:

•	 Off: No 3D effect is added.
•	 Shadow: Draw shadows behind bars, points, and the area of an area graph. 
•	 3D: Bars and area charts are drawn in a 3D fashion.

Mark Data Points. Adds small circular marks at data point locations.

Comparison Plot Style. Not used.

The Subset Tab
The Subset tab of the graphical 
display Customization  
dialogue box.
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Subsets. The subsets tab is used to add annotation to the graphs, typically East, 
North, Up or Beam 1, Beam 2, Beam 3.

The Axis Tab
The Axis tab of the graphical 
display Customization  
dialogue box.

Axis. This tab lets you specify axis type and range. Select between linear or 
logarithmic axes and the following range settings:

•	 Auto: Graph automatically determines min and max based on data.
•	 Min: Manually set Min and automatically set Max.
•	 Max: Manually set Max and automatically set Min.
•	 Min/Max: Manually set both the Min and Max. 

Additional parameter fields are available when meaningful, otherwise they ap-
pear ghosted.

The Font Tab

The font tab (not shown) lets you specify font size and appearance for the titles 
and annotations used in the graphs.

The Colour Tab

The colour tab (not shown) lets you specify the colours used in the graphs for the 
curves and the backgrounds. 

The Style Tab

The Style tab (not shown) lets you specify the look of each of the curves appear-
ing in a graph.

Exporting a Graph
Graphs can be exported to the Windows® clipboard as text, as Windows® Meta-
file, to a printer, or as files for use in other applications, such as reports and pres-
entations. Normally, we recommend that you save the graph as a file.
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The following formats are available:

•	 Metafile	 to be used for Clipboard, File, and Printer
•	 Bitmap 	 to be used for Clipboard, and File
•	 Text/Data	 to be used for Clipboard, and File
•	 JPEG 	 to be used for File

To export a graph:

1	 Press X when displaying the required graph or click the Export key in the 
Customization Dialogue box.

2 	 Select the type of export desired.

3 	 Select the destination of the export.

4 	 If available, select the size of the image to export.

5 	 Press the Export/Print button.
Tip! In general, we recommend 
that you convert the file to ASCII 
rather than exporting it as text 
from here.

	 Printer as destination. If your exporting a metafile to the printer, pressing the 
Print button will produce the Windows® Print dialogue box, which lets you print 
as usual. 
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The Different Graphs Available
The below screenshot examples of the available graphs are both shown in their 
standard look—no change of colours or other “tweaking” (as discussed in the 
above set of menus) has been applied.

The Profile tab shows the 
velocity profile in m/s and as 
amplitude in counts. The latter is 
an indicator of the strength of the 
received signal. For amplitude 
measurements, the counts-scale 
spans from 0 to 255. Typical 
noise level is around 20–30 
counts. To give you an idea of 
how much a count is, suffice it to 
say that one count corresponds 
to approximately 0.4 dB. Hence, 
counts are logarithmic by nature.

The Vel/Dir tab shows the 
combined velocity profile in 
East/North direction (Up is 
ignored). The corresponding 
direction is in degrees relative 
to North following traditional 
compass conventions so that 
positive (increasing) angles 
are clockwise (towards East). 
If you used XYZ, the direction 
angle will be relative to the X 
direction, but it will not follow the 
usual trigonometric conventions 
as compass conventions are 
preferred.

Other displays available:

Velocity tab. The Velocity screen (not shown) displays the velocity of the first 
cell in accordance with the coordinates you specified in the deployment setup. 

Amplitude tab. This screen (not shown) displays the velocity vs time of the first 
cell in counts (to indicate received signal strength) and in accordance with the 
coordinates you specified in the deployment setup. 
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Soundspeed tab. This screen (not shown) displays the sound speed vs. time. If 
your deployment setup uses fixed sound speed, this will be a flat line. If your 
deployment setup uses a keyed-in salinity and temperature, the sound speed will 
be calculated as the temperature changes. Note that any external CT sensors 
connected will be logged only. The information they provide will not be used in 
the Aquadopp’s own measurement. 

Temperature tab. This screen (not shown) displays the temperature vs. time 
based on the Aquadopp’s internal thermometer. 

Pressure tab. This screen (not shown) displays the pressure vs. time based on 
the Aquadopp’s internal pressure sensor. 

Battery tab. This screen (not shown) displays the battery voltage vs. time based 
on the Aquadopp’s internal voltage measurement. 

Attitude tab. This screen  (not shown) shows the head, pitch, and roll of the 
Aquadopp vs. time. 

Analogue tab. This screen (not shown) shows the signals received from ana-
logue sensors connected to the analogue inputs of the Aquadopp. 
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CHAPTER 8
Getting Recorded Data out
This chapter explains how to get the data out of the Aquadopp Profiler by means 
of the AquaPro software. If you are going to do post processing in programs like 
Microsoft® Excel and MATLAB® the data must be converted to ASCII format 
first. This chapter shows you how.

Retrieving Data from the Instrument
To retrieve data from the instrument: 

1	 Click Deployment > Stop Recorder Deployment or click the corresponding 
icon.

By clicking Deployment > 
Stop Recorder Deployment 
you will be able to compare 
the instrument’s realtime clock 
setting time with that of the PC.

2	 Click Deployment > Recorder Data retrieval or click the corresponding icon. 
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CHAPTER 8
Getting the Recorded Data out

Within a moment, you will see a list of the recorded data files – in the case of 
more than one file, the most recent file will be the last one listed: 

Recorder data retrieval. See also 
text for details.

Causes the 
program to 
automatically 
split the data 
in several files 
when retrieving 
to disk. Specify 
the maximum 
file size in the 
Max size box. 

Dumps data 
from the re-
corder. Use 
this option for 
recorder trou-
bleshooting.

Check this 
option to 
enable CRC 
control 
during data 
conversion

The following options are available:

 •	 Split file. This option causes the program to automatically split the data in 
several files when retrieving to disk. Specify the maximum file size in the 
Max size box. Use this option to e.g. save data in disk files that will fit on 
floppy disks (max 1.38 Mb). The files will have a sequence number appended 
to their filename (e.g. mydata_1.prf, mydata_2.prf, ...).

 •	 Include header. Includes header data with each file. If not checked, only the 
first file will have header data included.

 •	 Max size. Specify the maximum split file size in Mbytes.

 •	 Dump. Dumps data from the recorder. Use this option for recorder trouble-
shooting.

 •	 Amount. Specify the number of kbytes to retrieve. Use this option for re-
corder troubleshooting.

 •	 Offset. Specify a recorder position in kbytes from the start of the recorder for 
data dump.

 •	 Include FAT. Includes the recorder file allocation table (FAT) in the dump 
file.

 •	 CRC check. Check this option to enable CRC control during data conver-
sion.
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2	 Highlight the file you want, click Retrieve and select the location for the file: 

3	 The selected file will now be retrieved and put on your hard drive.

Converting to ASCII Format
To convert the retrieved data into ASCII format:

1	 Click Deployment > Data Conversion or click the corresponding icon.

	 The following options are available:

 •		 Files to convert. Lists files that may be selected for conversion. To convert 
files select items in the list and press the blue arrow.

 •		 Converted files. Lists converted files.
 •		 Add file. Displays a file selection dialog box where you can select files to 

add to the Files to convert list.
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 •		 Remove. Removes the selected files from the list.
 •		 Select All. Selects all files in the Files to convert list.
 •		 Checksum control. Performs checksum control during data conversion.
 •		 Burst files. Splits data collected in burst mode into separate files. The files 

will have a sequence number appended to their names.
 •		 Show path names. Shows files with full path names in file lists.
 •		 Add prefix. Specify text to be inserted in front of the recorder file name for 

the converted files.
 •		 Add postfix. Specify text to be appended to the recorder filename for the 

converted files.
 •		 View file. Selects a converted file in the drop-down list to open in Note-

pad.
 •		 Save in folder. Specify the location to put converted data  files.
 •		 Browse. Displays a folder selection dialog box where you can select the 

location to put converted data files.

2	 Define where to put the converted files (Save in folder). As default this is set 
to the same folder as the file to be converted resides in.

	

3	 Click Add file... to insert files for conversion. Select files (use the SHIFT key 
and/or the CTRL key to select more than one file) and click Open.

4	 Files selected will now be inserted in the left column. Repeat 3 if you want to 
convert files from other folders.

CHAPTER 8
Getting the Recorded Data out



Aquadopp CURRENT PROFILER
User Guide

71

Doc. No: N3009-103 • Revision C • 01.2008

5	 Once you have entered all the files required, highlight (by selecting) the files 
to be converted and click the arrow between the two columns:

6	 You will now be prompted to specify what part of the files you want to convert:
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7	 To view the contents of a converted file, select what part or type you would 
like to inspect:

This will start Notepad (unless your PC is configured otherwise) and show the 
contents of the selected file:

The contents of a converted 
file is shown in Notepad on a 
Windows® 2000 system. 

Finish Operations
Tip! To conserve the batteries 
when the Aquadopp is not to be 
used for a period of time, be sure 
it is not in data acquisition mode.

	 Be sure to stop any data recording using one of the Stop buttons before you put  
the Aquadopp on the shelf or in the back of your car after use.

Erasing Recorded Data
Erase the recorder by clicking Deployment > Erase Recorder. Before you do 
this, make sure that you have recovered your data, that the data file has not been 
corrupted and that you have stored a backup copy.
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Binary Data Files
Tip! Use our web site (http:
//www.nortek-as.com) to get 
access to the latest tech-notes 
and user experiences regarding 
i.a. data analysis.

	 Binary files created by the AquaPro program all use the same format, whether 
internally recorded or recorded using the real-time Record to Disk option. Bi-
nary data files include a header (50–100 bytes long), and each data record adds 
32 bytes + 9 × NCELLS. The binary file format is not documented here, since it is 
all shown in the header file – see example overleaf. 
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An example of parts of the 
header file showing that the 
data format is well documented 
in the header file itself. This will 
ensure that no matter how many 
firmware upgrades you do, you 
will always have access to the 
format used when the acquired 
data was downloaded.
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CHAPTER 9
Operational Concerns

My Data Fails to Look Right
The Aquadopp Profiler cannot measure velocity properly if the water has too few 
scatterers. Your data will be questionable when signal levels are down around 
the noise level—which is about 20–30 counts for the 2 MHz version, 25–35 
counts for the 1 MHz, and  30–40 counts for the 600 kHz version.. 

If your data doesn’t look right, particularly if you have unrealistic vertical veloci-
ties, consider the possibility that one or more of the beams were blocked. If the 
blockage is somewhere inside the measurement cell of one beam, you should see 
elevated signal strength for that beam. If the blockage is closer to the instrument, 
the signal strength may not look very different from the other beams, or it could 
be substantially reduced. 

If you can collect data in real time while the instrument is deployed, do as 
follows to see if there are any obvious obstructions in any of the beams:

1	 Set up the instrument to measure using 1s measurement interval.
2	 Select the Profile tab from the Data display selection bar.
3	 Look for strong reflections.

Correcting Data for Sound Speed Errors
If you enter the wrong salinity, the Aquadopp  Profiler will compute an incor-
rect sound speed. You can correct velocities (V) for sound speed errors using the 
following equation:

Vnew = Vold
New sound speed

Old sound speed
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CHAPTER 9
Operational Concerns

Data already acquired cannot be corrected from within the Aquadopp software, 
so you will have to do this for yourself or add a correction term to all applicable 
values when importing ASCII converted data to Excel or MATLAB®.

Boundaries and Sidelobes
Profilers looking up or down typically loose data near the surface or bottom. 
This loss is caused by contamination of the near-surface data by sidelobe echoes. 
The acoustic beams focus most of the energy in the centre of the beams, but a 
small amount leaks out in other directions. Because sound reflects much better 
from the water surface than it does from the water, the small signals that travel 
straight to the surface can produce sufficient echo to contaminate the signal 
from the water.

H 
(Distance to surface)

H 
α

The geometry of profiler  
sidelobe interference. Only a 
few cells are shown for clarifica-
tion. The top cell of the beam 
is shown as if it were extending 
into the air. This has been done 
to give a better indication of the 
surface position.
Note that α is 25° for all Aqua-
dopp Profilers.

  indicates cell OK

  indicates cell not OK

RMAX









 
Surface

The above Fig. illustrates how this works. If the distance to the surface is A, then 
contamination of the current measurements at the same distance A along the 
slanted beams. In the Figure, the top two cells are contaminated. The following 
is an approximate equation for near-surface contamination: 

Rmax = H cosα 
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where Rmax is the maximum range for good data, α is the angle of the beam rela-
tive to vertical (25° for all Aquadopp Profiler models), and Cell is the cell size. 
Note that in this context a cell is either good or contaminated—it cannot be 
partly OK. Consequently, the last good cell will be the one below the limit Rmax.

Grounding Problems
Tests in laboratory tanks can sometimes lead to grounding problems, which 
show up as elevated noise levels, but only after the instrument is placed in the 
water. You will not automatically see the increased noise level in your data if 
your signal from the water is above the noise, but the increased noise level could 
look like signal. 

Grounding problemsis normally only a problem during the tests and velocity 
calibration. Feel free to contact Nortek for further guidance. Keep in mind that 
grounding problems occur around man-made structures, but are not normally a 
problem in the field.

Mooring Tilt
Sometimes moorings tilt excessively or even fall over. If the Aquadopp Profiler’s 
tilt reading is 20º or less, your data should be within the specifications. Tilt read
ings between 20º and 30° affect the data accuracy in a way that is likely to make 
the data fail to meet the specifications. Data acquired during tilts exceeding 30° 
are in general not reliable and should be discarded.

Mooring Vibration
Excessive mooring vibration can adversely affect your data. Vibration introduc-
es spurious velocities and interferes with the proper operation of the tilt sensor. 
If you discover that mooring vibration is a problem, you should try to find ways 
to reduce the vibration. 

Troubleshooting

Simple Problems
Most initial problems can be traced to forgetting to power the system, the DB-9 
connector falling out of the computer, or using the wrong serial port. Remember 
that new Aquadopp Profilers ship with the battery disconnected.

Computers don’t always behave as they should and not all of them have serial 
ports available, so you may need to get a USB–RS 232 converter. If one compu-
ter is giving you a problem, try another one instead.
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Power management can be a serious problem sometimes. If power management 
takes over the PC, data downloads can be disrupted sufficiently to cause the 
transfer to fail. Power management is most commonly enabled in laptop comput-
ers, but it can be enabled in desktops as well.

Problems Detecting the Instrument on the Serial Port
If you cannot connect to the instrument, first try sending a break to the 
Aquadopp. Send a break by clicking Communication > Terminal emulator, and 
then clicking the Send Break button. If the Aquadopp is powered and properly 
connected, and if the terminal is set to use the correct serial port, then you will 
see the Aquadopp’s wake-up message.

If you see a response consisting of garbled text or strange characters, then the 
Aquadopp and terminal program are probably using different baud rates—you 
could experiment by trying different baud rates (Terminal > Serial port). If you 
suspect your computer is having problems, try a different one. You can also 
verify your serial port and cable with a serial loop-back test (see below).

Serial Loop-back Test
The serial loop-back test verifies that the serial port can receive the same char-
acters it sends. First, make a loop-back connector (see the Fig. below) and plug 
it into your serial port. Run the test by typing characters—whatever you type 
should be echoed to the screen. When you remove the connector, the characters 
stop echoing back.

Run the test with the Aquadopp’s built-in terminal emulator, and if that doesn’t 
work, try HyperTerminal instead (a terminal program that comes with Win-
dows).

Test your serial cable the same way. Plug the cable into the computer and put a 
loop-back connector on the end of the cable. If your serial cable passes the test 
and you still cannot wake up the instrument, there is a chance that your cable is a 
null modem cable—if so, it crosses wires 2 and 3. You can test this by substitut-
ing a different cable or by using a null-modem adaptor in series with the cable 
(which crosses wires 2 and 3 back).

CHAPTER 9
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CHAPTER 10
Maintenance
Before you assemble a system that involves custom cables, power supplies or the 
like, first assemble and test the Aquadopp using just the cables and battery that 
come with the system. This is the easiest way to get the system to work, and if 
you have trouble you can always return to this setup to confirm that problems are 
not caused by a faulty instrument.

Preventive Maintenance 

Cleaning
Perform regular cleaning of the Aquadopp Current Profiler. Use a mild detergent 
to clean the Aquadopp. Pay special attention to the transducers.

Check the pressure sensor and remove any dirt in the two front holes.

Antifouling
Antifouling paints and other agents are often used to avoid transducers get-
ting covered with barnacles or other evil crustacés during long deployments. 
Depending on the water temperature, fouling can be a problem already after 2 
weeks in tropical areas or it can take 6 months in cold areas. Sunlight is also a 
big factor—fouling is generally much less of a problem below 100 m than it is 
at 5 m.
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Here are some things people do (quotes cut from various newsgroup postings 
and from emails we have received):

“In general when antifouling any [acoustic Current Profiler] for a long de-
ployment we use plastic bags. Thin plastic bags of the type used as liners 
for small household or office bins work really well. Stretch them over the 
[acoustic Current Profiler] and then bind them in place with ducting tape. You 
need to put some tiny pinprick holes in the top of the bags so any trapped 
air can escape but the holes are too small to allow any organisms to enter.” 
 

“We use zinc oxide as can be found in children’s ointments. A small amount on 
the high-frequency transducers and we see no sign of fouling.” 

“We have been pleased with Pettit’s Trinidad anti-fouling paint (75.8% cuprous 
oxide).”

Replacing the Desiccant
Keep water out of the open pressure case. Both fresh and salt water can corrode 
the circuitry.

At least once a year, replace the desiccant located behind the internal battery. 
Refer to the battery installation procedure for detailed information.

Installing / Changing Batteries


Use a CRT monitor and not an 
LCD monitor when degaussing 
alkaline batteries.

	 Alkaline batteries should be degaussed before you use them in your instru-
ments—you can do this yourself by placing the padded end of the battery up 
against the centre of your PC monitor (CRTs, not LCD screens) and using the 
monitor’s degaussing function. 

Always be sure to include desiccant in the pressure case. Humid air can con-
dense enough water to damage the electrical circuitry.

To replace the battery pack:

1	 Remove the four screws (1) and washers holding the end cap to the pressure 
case and remove the pressure case.

CHAPTER 10
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2	 Disconnect the 2-pin connector (2) and pull the old battery (3) out of the pres-
sure case.

3	 Slide in a new battery and connect it to the 2-pin connector.

4	 Insert the end cap to the pressure case and mount the four screws and wash-
ers. Tighten the screws carefully to avoid damaging the threads in the pres-
sure case. Tighten the screws only until the end-cap touches the pressure case 
and you can just feel that they are seated. Keep in mind that ocean pressure 
holds the end cap in tightly – all the screws have to do is to keep the end cap 
from falling out when the system is above water.

	 Take care when handling the O-ring and the O-ring surfaces.

5	 Test communication with the Aquadopp’s built-in terminal emulator program 
by sending a ‘break’ command to the instrument. If it is wired correctly then 
you should see the Aquadopp’s wake-up message on the screen (it will give 
you the model of your instrument plus the firmware version number). If you 
get a string of garbage characters try another baud rate setting. When the 
instrument responds to a ‘break’ properly then the communication lines are 
correctly connected. An easy alternative for using the terminal emulator is to 
read the configuration file directly from the instrument (Deployment > Plan-
ning > Load from instrument). If the instrument is set for a different baud 
rate than the software expects, it will search for the correct baud rate and 
connect automatically. 

6	 Test the instrument by collecting data without using an external power source 
to ensure that the battery is properly connected. Make sure to stop data collec-
tion so that the instrument will power down after you are through testing it.

7	 Check and/or reset the clock if necessary.

8	 Because the battery pack uses standard alkaline batteries, you do not normal-
ly need to observe any special precautions when you dispose of old batteries

If you have lithium batteries, keep in mind that you must be very careful and that 
disposal requires special precautions and/or procedures. Legislation for disposal 
of batteries, especially lithium batteries, vary from country to country.

Corrective Maintenance
Only qualified personnel are allowed to perform corrective maintenance activi-
ties. Please refer to the separate service manual or contact NORTEK for further 
assistance.
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APPENDIX 
Returning Aquadopp for Repair
Before any product is returned for repair you must have obtained a Return Mer-
chandise Authorization (RMA) in writing from Nortek AS.

Copy the Proforma Invoice template overleaf, or make your own, but be sure to 
include all the information requested in the Proforma invoice.

Also, be sure to include a copy of all shipping and export documents inside the 
freight box.

Important!  Freight insurance on repairs is not covered by Nortek AS. You 
must make sure your goods are properly insured before shipment. Nortek AS 
is by no means liable if the instrument is damaged or disappear while being 
shipped to Nortek AS for repair. Likewise, Nortek AS is not liable for conse-
quential damages as a result of instruments becoming damaged or disappear-
ing while being shipped to Nortek AS for repair.

Nortek AS will insure the instrument upon returning the goods to you and 
invoice you for this, along with the repair- and freight costs.

If the instrument is under warranty repair, the transport and freight insurance 
from Nortek AS back to you will be covered by Nortek AS.



Proforma Invoice
SENDER (Exporter) RECEIVER

Name: Name: Nortek AS

Address: Vangkroken 2 

City:   NO-1351 Rud

Country: Norway

Tel.:   +47 67174 500

Fax:   +47 6713 67 70

E-mail: inquiry@nortek.no

Contact: Jonas Røstad

Address:

City:

Country:

Tel.:

Fax:

Ref.:

About the Goods

Date: No. of Units: Weight:

Delivery Terms: Customs Account No.: 28605-56

Description of Goods: Origin: NO Value:

Total Value:

Nortek RMA No:
Reason for Export:

Date:
Exporter’s signature

To fill in form, select the hand tool and position cursor in a textbox. Use Tab or mouse to move between boxes. When 
ready click OK, print out the form, sign it and send it with the returned mechandise. Press reset to start all over again.

Scientific instrument temporarily returned for repair. Customs classification: 9015.90.90
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